Creating a New Plan

lllustrated Beginners Guide
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Creating a project plan in MS Project isn’t -

that difficult.

In the following slides, I'll show how to
create a simple project plan using a real
project example.
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Setting up a new project -
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Let’s create a new project and make -

some general adjustments.

By the way I'm using MS Project 2016
here.
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STEP 1:

CREATING THE PROJECT

» After MS Project has launched,

choose: i 2 i ==
File > New > Blank Project =38 =3 [{EEs
* When you create a new project, = =t T
MS Project sets the current date as == === 3
the plan’s start date. ==




STEP 2:

GENERAL PROJECT SETTINGS

Gantt Chart Tools

e For eve ry new project’ you want to Report ISl View Format Q Tell me
chan ' ' -
ge some key information H & Bl i
befO re Contl Nnul ng . Project |Custom Agile Links Between WBS Change
Information| Fields Projects ~  Working Time

Properties

» Go to:
Project > Project Information
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STEP 2.1:

PROJECT START DATE

 Enter the start date of
your project

* Don’t worry, you can
change the start date
later.

oject Information for ‘Project1’

Start date: u 01.03.18 v § Current date: = Wed 15.08.18 v

Wed 15.08.18

Finish date: Status date: NA

Schedule from: | Project Start Date v | Calendar: Standard v

All tasks begin as soon as possible.

Priority:

Enterprise Custom Fields
Department:

Custom Field Name

Help | | statistics..
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See field Calendar in the same dialog:

poooo
ooooo
ooo

Here you can select alternative calendars:

Standard — 8-hour work days from Monday to
Friday, with 1-hour break (use this one)

STEP 2.2
SET THE @ :l\(ci:nn;r?i = ifthere are no breaks and no non-
CALENDAR

Night Shift — Covers 11 pm to 8 am an all nights
A from Monday to Friday, with one hour breaks

Once you have made the settings, choose “OK”
to close the dialog box
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Now, let’s create a real project

I’m not going to bore you with an artificial project like ‘how to bake a cake’ or that kind of
BS. We'll create the plan for a real project.

In this case, it’s a project where a company is moving to a new office space,
and we are in charge of planning the move, including getting office furniture and
all office stuff shipped to the new location. And we want to do this without interfering with

daily business.

People should be able to do their work, then on the weekend all items will be
transferred, so that your colleagues can start working from the new office building the

following Monday.
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Goal

» Office relocation

Key project Timeline

 March — October
data

Project phases

* Project preparation, Selection of
offices, Space design and
furnishing, Physical relocation
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Building the Task List -
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Task
Mode v  Task Name v | Duration

Set up project organization

3 A2 Create project plan
E N T E R TAS KS - A2 Nominate in-house relocation
coordinator

Establish a budget

6 A2 Define relocation requirements
(space, location etc.)

Project approved by management

Now enter the tasks for the first project
phase in the tabular view
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ENTER TASK
DURATION

* Now we enter the start and
finish date for each task.

* In this case, MS Project
automatically calculates the
duration

» Tip: You can also enter a
start date and a duration and
let MS Project calculate the
Finish date.

Task
0 Mode v Task Name v  Duration ~ §| Start v Finish v §Predecessors

Set up project organization 22 days Thu 01.03.18 Fri 30.03.18
b 4 Create project plan 22 days Thu 01.03.18 Fri 30.03.18

4 b 4 Nominate in-house relocation 22 days Thu 01.03.18 Fri 30.03.18
coordinator

5 b4 Establish a budget 5 days Mon 26.03.1! Fri 30.03.18

6 » Define relocation requirements 22 days Thu 01.03.18 Fri 30.03.18
(space, location etc.)

Project approved by management 1day Thu 29.03.18 Thu 29.03.18|
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When entering
duration, use

the following
logic:

Duration you want to enter
30 minutes

6 hours

3 days

6 weeks

4 months
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What to enter

30m

2h

3d

6w

How it appears in MS Project
30 mins

6 hrs

3 days

6 weeks

4 months




Now we have to talk about how Project uses those

values to calculate the duration of your project.

When you enter for example a duration of 12 days for a
task, the task will span across 3 weeks.

Why? In MS Project’s default configuration, a week as
only 5 workdays.

Therefore the task will consume two full weeks plus 2
days of the 3rd week. Got it?

The table on the right shows you what default
settings apply
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Value entered  Value MS Project default value

1 month 28 to 31 days, depending on the month 160 hours (20 workdays)

1 week 7 days 40 hours (5 workdays)

24 hours

1day 8 hours (1 workday)

1 hour 60 minutes 60 minutes




OPTIONAL.:

CHANGE DEFAULT CALENDAR AND TIME SETTINGS

* You can change the time * To change the settings, goto
settings and even create a new the Project tab —> Change Working
calendar based on your needs. Time

This is great if you want MS

Project to consider country or
company-specific non-working H S ’ GRIRE Chwe: Tooks
days.

Task Resource Report Project " Format

C: 0

| S, o

Subproject 3 My Add-ins ~ Project Custom Agile Links Between W
; Information Fields Projects

« Remember, in the default
setting every day from Monday
through Friday is considered a
normal working day by Microsoft
Project.

Insert Add-ins Properties
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» Here you can change the calendar » Go to Options —> Schedule to

settings (e.g. mark specific days as change default working hours.

nonworking days). To change the Press “OK” to save the settings.
default time settings, click

“Options”.

Change Working Time “ [y Project Options
. sener. — -
For calendar: | Standard (Project Calendar) v Create New Calendar ... peneE ®=_| Change options related to scheduling, calendars, and calculations u
Calendar 'Standard’ is a base calendar. Display
| Schedule Calendar options for this project: | @3 Project] -
Legend: Click on a day to see its working times: ~ Working times for 15 August 2018: I Proofing
August 2018 ~ ; Monday -~
Working « 08:00 to 12:00 Save sin: | January v
MITIWITh|F]S|S + 13:00 to 17:00 Bl
. 112(13[4]5 Language
Nonworking

617189 1011 [12 Default start time These times are assigned to tasks when you enter a start or finish
10 e ) date without specifying a time. If you change this setting, consider
21 Edited working hours IENEY) E 76117 112 [12 Default end time matching the project calendar using the Change Working Time
* Based on: Py - command on the Project tab in the ribbon.
On this calendar: 20 |21 |22 [23 24 |25 [26 Default work week on calendar Hours pet 2oy - z ’
31 Exception day :

Hours per week

27 |28 (29 (30 |31 Days per month: 20

31! Nondefault work week

Schedule
Exceptions | Work Weeks [ Show scheduling m
assignment units as a: | Percentage ~
Name Start Finish A Details..
Delete Scheduling options for this project: | @5 Project] v
New tasks created: Manually Scheduled ~

sched ks scheduled on: | Project Start Date ~

on is enter Days i
entered in: Hours v

ult task type Fixed Units v

[V Split in-progress tasks

OK
Help OK Cancel

Cancel
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CREATING SUMMARY TASKS

When you have to manage dozens or even hundreds of tasks, it
makes sense to group tasks together into summary tasks.

A summary task is not an actual task. It's more like a “wrapper” to
group several related tasks together under one name. Duration, start
and end date of a summary task depends on the tasks included under
the summary task. The start date will be the earliest start date of all
subordinated tasks. Likewise, the end date of a summary task is
equal to the latest end date of the subordinated tasks.
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To create a summary task, we
first create a new task above the
first one.

Select the 2nd row, press the
right mouse button and
choose Insert Task:

In the new row, enter the new
task Project preparation:

Calibri ~ 1 -
B I OH-A-eocyss.

T””
¢||||

v Duration

v Start v  Finish

Wk w N =

[=-]

1
2 | | | Setup project organization 22 days Thu 01.03.18 Fri 30.03.18
3 do Lt e project plan Fri 30.03.18
4B Copy nate in-house relocation Select task

o Past linator .
410 == - above which you want to
: Paste Special... lish a budget .
6 locatics insert a new

my  Scroll to Task A

Choose
o et Task Insert task Aday Thu 29.03.18 Thu 29.03.18
Delete Task
Task
0 Mode v | Task Name v | Duration v Start v Finish v

Thu 01.03.18 Fri 30.03.18

A Project preparation |22 days

A Set up project organization 22 days

A Create project plan 22 days

A Nominate in-house relocation 22 days
coordinator

A Establish a budget 5days

A Define relocation requirements 22 days
(space, location etc.)

A Project approved by management 1day
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Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18

Mon 26.03.1! Fri 30.03.18
Thu 01.03.18 Fri 30.03.18

Thu 29.03.18 Thu 29.03.18




Now, select rows 3-8 and
press the indentation button
in the Format tab:

You should get the following
result:

Font M
Task

0 Mode v Task Name v Duration
]
2 A 4 Project preparation 22 days
3 A Set up project organization 22 days
4 A Create project plan 22 days
5 A Nominate in-house relocation 22 days

coordinator

6 A Establish a budget 5days

7 b Define relocation requirements 22 days
(space, location etc.)

Project approved by managemer 1 day

/e tacticalprojectmanager

+ | Finish v | Predecessors

v Start

Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18

Mon 26.03.1: Fri 30.03.18
Thu 01.03.18 Fri 30.03.18

Thu 29.03.18 Thu 29.03.18

v



Project preparation is now a summary task. You can see this by
the bold font and the little black triangle next to the task.

Project preparation is our first project phase during which we set
up the project, including creating a project plan, staffing the
project and creating a project budget.

Tip: You can create more levels of depth, depending on the
complexity of your project. All you have to do is define a
summary task and indenting the activities that should be rolled

up.
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https://www.tacticalprojectmanager.com/budgeting/project-budget-management/

BEFORE YOU CONTINUE,

TAKE A LOOK AT THE
GANTT CHART

March 2018 }
Task Name v Duration v Start v Finish v | Predec 22 27 04 09 14 19 24 29

| want you to take a look at the
nice Gantt chart that MS Project
has created automatically for our
project.

4 Project preparation 22days  Thu 01.03.18 Fri 30.03.18
Set up project organization 22days  Thu01.03.18 Fri 30.03.18 i i
Create project plan 22days  Thu01.03.18 Fri 30.03.18 [ f

Nominate in-house relocation 22days  Thu01.03.18 Fri 30.03.18 i i
coordinator

Establish a budget 5 days Mon 26.03.1i Fri 30.03.18 : I

Define relocation requirements 22 days  Thu 01.03.18 Fri 30.03.18 B f
(space, location etc.) :

The Gantt chart is a visualization
of the project using bar charts.
You can see it in the right side of
the screen.

Project approved by 1day Thu 29.03.18 Thu 29.03.18 : Gantt chart* 1
management :

(Did you know? You can
also create a nice Gantt chart in
Excel)

(you can also create Gantt charts easily in Excel)
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https://www.tacticalprojectmanager.com/planning/creating-gantt-chart-excel-with-template
https://www.tacticalprojectmanager.com/planning/creating-gantt-chart-excel-with-template

CREATING A

MILESTONE

Milestones are specific points on the project
timeline. They are used to measure or review
the progress of a project, and to inform
management and stakeholders about the
current status. Technically, a milestone is like a
task with zero duration. Milestones are used as
markers for major achievements, such

as “construction completed” or “project
approved by management’.

To create a milestone, select a task and right-
click —=> Go to Advanced and check
“Milestone” in the dialog box:

Text Stvles act plan 22 days
Jext otyles...
- n-house relocation 22 days
L] Information... |
Notes... sudget 5 days

“sa Addto Timeline cation requirements 22 days
@, Link tion etc.)

& | Vg rroject approved by management 1day

Task Information % n

Duration: | 1 day

Name: | Project approved by management

Constrain task

Deadline: NA v

Fixed Units

Calendar: None v
WBS cod 1.6
Earn alue method: % Complete v

[w] Mark task as milestone
Some of the fields above are not editable because the task is Manually Scheduled.

Effort driven

2 [[]Estimated

Scheduling ignores resource calendars

Cancel

Help [ ok
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Once you click “OK?”, take a look at the Gannt view.
You now see the task is marked as a diamond with a date next to it.

Here it is: Project approved by management is now a milestone:

L S S

Task
Mode v Task Name

A 4 Project preparation

A Set up project organization

A Create project plan

A Nominate in-house relocation
coordinator

A Establish a budget

A Define relocation requirements

(space, location etc.)
A Project approved by management

v Duration v | Start

22 days
22 days
22 days
22 days

5days
22 days

1day

March 2018 April 2018

v | Finish v Bl 22 27 04 09 14 19 24 29 03 08

Thu 01.03.18 Fri 30.03.18
Thu 01.03.18 Fri 30.03.18 [ i
Thu 01.03.18 Fri 30.03.18 A ;
Thu 01.03.18 Fri 30.03.18 [ i
Mon 26.03.1: Fri 30.03.18 I n
Thu 01.03.18 Fri 30.03.18 ! :
task is now a milestone
Thu 29.03.18 Thu 29.03.18

¢ 29.03
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Project-related tasks have to
v = performed in a specific order,
LI N KI N G > so that we can accomplish the
T AS KS I N A project objectives.
SPECIFIC
Once you have entered the list
SEQU ENCE — of tasks, it is time to link these

eee tasks together.
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Take a look at the screenshot:

You can see our two project phases Project
preparation and Selection of offices in bold. Both are

summary tasks (scroll up if you’ve missed how to o . S o -
ask Name v Duration v Start v  Finisi vjl Predecessors «
Create Summary taSkS)' | 4 Project preparation 4,4wks Thu01.03.18  Fri30.03.18 .
2 Set up project organization 2,4 wks Thu01.03.18  Fri16.03.18
In the logical sequence, Selection of offices should * | Cresteprojectplan dwks Thu0L03.18 [P 30.08.18
. . . 4 Nominate in-house relocation coordinator 4,4 wks Thu 01.03.18  Fri 30.03.18
come after Pro.leCt preparatlon IS Complete Establish a budget 1wk Mon 26.03.18  Fri 30.03.18
6 Define relocation requirements (space, location etc.) 4,4 wks Thu01.03.18  Fri30.03.18 *
Using the terminology of MS Project, we must 7 Project approved by management 1day Thu29.03.18  Thu29.03.18
. . 4 Selection of offices 20 wks Mon 02.04.18  Fri 17.08.18 1
make PI’OjeCt preparatlon the predecessor Source & brief property consultant(s) 2 wks Mon 02.04.18  Fri 13.04.18
of Selection of offices, which means it should come 10 Interview property consultant(s) 1wk Mon16.04.18 Fri20.04.18 |3
before the Ofﬁce SeleCtion phase. i Select & instruct property consultant 1wk Mon 23.04.18  Fri 27.04.18 10
12 Inspect potential business space with property consultant 4 wks Mon 30.04.18  Fri 25.05.18 1
13 Source & brief property solicitor(s) 2 wks Mon 02.04.18  Fri 13.04.18
We can easily make Proj ect preparation the 7 Select & instruct property solicitor 1wk Mon16.04.18 Fri20.0418 |13

predecessor by entering “1” as the predecessor
number in the “Predecessors” column. “1” is the task
number of Project preparation.
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Congratulations! -
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As | told you at the beginning, MS Project isn’t

that hard to use. | suggest you spend some
more time playing around with Project and
working with your sample project.

, u
tSp?(cificaIIy, you should practice the following Yo u ve j USt
asks:

| | created
» Creating a new project .
» Entering new tasks you r fl rSt

* Adjusting duration, start and end date of

jass project plan

 Linking several tasks together in a specific
sequence =
 Printing the project plan I n M S
« Saving your new project & P n
roject!
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Manual vs. automatic scheduling
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One last point | want to touch before you
leave is manual vs. automatic scheduling.

MS Project supports two ways of scheduling
tasks and calculating the overall project
timeline.
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Which
method
should you
choose?

Ooooo
oooo
ooo
ooo

oono
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In manual scheduling, you set the start
and end date manually for every task. For
example, you might say “Our business
planning workshops will take place from
Wednesday September 5th til Friday
September 14th”. Then you schedule this
activity for those exact days.

In automatic scheduling, you set the
start date for the entire project, and you
define how long each task will take to
complete (“Our business planning
workshop takes 5 days”). Then, once
you've set the dependencies (linking the
tasks in the right sequence), Project is
able to calculate the entire schedule
automatically for you.




Of course, in its default configuration, MS Project doesn’t
consider your individual scheduling preferences.

If you have a developer who works only 3 days per week,
Project would not know that, and an automatically
generated plan would be inconsistent with your actual
circumstances.

That's because Project would assume that any task can
be scheduled on all 5 workdays.
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Which scheduling mode should you use?

| recommend you always start with manual, and that you only switch to
automatic mode once you know exactly what tasks have to be
performed, how long they will take etc. It's also perfectly fine to stay

with manual scheduling!

Read my article: Manual vs Automatic scheduling Explained
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What questions do you have?

With this article my goal was to get you started with MS Project, so
naturally there will be more topics you want to know about.

Tell me what you most burning questions are.

I'll answer every question you ask.
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THANK YOU! -




